LINIVERSI DADE

ADBERTA

www.univ-ab.pt

Curso Pratico:

ESSENCIAL DO WINDOWS

O Essencial do Windows é um texto introdutdério ao Sistema Operativo Microsoft Windows.
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1. FICHEIROS E PASTAS

Todo o conteddo guardado num computador, estd organizado em ficheiros. Um ficheiro num
computador pode conter tanto um programa como um documento criado pelo utilizador.

Um programa (exemplos: Bloco de Notas (Notepad), Calculadora (Calculator), Paint (Paint)) oferece um
conjunto de funcionalidades ao utilizador para que este possa efectuar um determinado tipo de tarefa
com o computador, como editar um ficheiro de texto, fazer contas, ou editar uma imagem. O termo
aplicagao é utilizado em vez de programa, para programas que o utilizador mande executar
directamente. Realgamos desta forma a fung¢do do programa, ou seja se é um programa pertencente ao
sistema, “programa de sistema” (system program) ou se é um programa destinado aos utilizadores
“programa de aplicagdo” (application program).

Um documento é um ficheiro que é editado pelo utilizador com uma aplicagdo durante uma sessdo de
trabalho, sendo no final gravado o ficheiro com o resultado do trabalho. Nem todas as aplicacdes editam
documentos, por exemplo a Calculadora oferece as funcionalidades de uma calculadora, e ndo edita
documentos, ou seja, ndo ha nada gravado apds a sua utilizagdo. Ja o Bloco de Notas edita ficheiros de
texto, pelo que no final da sessdo deve-se gravar o documento editado, que é um ficheiro de texto (se
nao se gravar perde-se o trabalho realizado). O Paint edita imagens.

Neste capitulo vamos centrar-nos na gestao de ficheiros. No capitulo seguinte falaremos de aplicagGes e
documentos.

ORGANIZACAO

A organizagdo dos ficheiros e pastas no computador ndo sdo mais que uma réplica da organizacdo que
existe no mundo fisico dos objectos e locais onde estdo. Por exemplo os objectos de uma casa estdo
organizados em quartos, dentro dos quartos em armarios, e em cada armario em prateleiras ou gavetas.
Mesmo as gavetas podem estar subdivididas. No computador podemos fazer equivaler os objectos aos
ficheiros, e os quartos, armarios, prateleiras e gavetas a pastas.

Uma pasta (também chamada directoria) ndo é mais que um local no computador que pode conter
ficheiros e outras pastas. Ao contrario do espaco fisico na casa, no computador pode-se criar / editar /
apagar pastas com muita facilidade, de acordo com as conveniéncias, e ndo existem restri¢ées fisicas ao
volume e tipo dos objectos a colocar em cada pasta. Existe apenas uma restricdo global: o espaco total
dos ficheiros ndo pode ultrapassar a capacidade do disco, que é normalmente suficientemente grande
para nao chegar a criar problemas.

A facilidade em editar pastas num computador e a ndo existéncia de restri¢des fisicas, ndo significa que
a organizacdo dos ficheiros no computador seja mais facil que a "arrumacao" dos objectos em casa. Na
verdade, ao utilizar o computador com frequéncia e para uma grande diversidade de assuntos, um
utilizador acabara por editar muitos ficheiros ao longo do tempo, e mais cedo ou mais tarde ira ter que
encontrar o local onde os ficheiros estdo. Se tiver os ficheiros mal organizados, tera mais dificuldade em
encontrar o ficheiro pretendido, tal como numa casa pode ndao conseguir encontrar um objecto.

No computador ha técnicas que facilitam encontrar o ficheiro perdido, tema abordado no capitulo 3, no
entanto ndo ha nada que substitua uma boa organizagdo inicial de ficheiros e pastas.
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Vamos supor que um utilizador pretende organizar os seguintes tipos de documentos:

1. Factura electrénica da agua;

2. Comprovativo de pagamento do imposto de selo;
3. Relatodrio de actividades da empresa;

4. Proposta do projecto A;

5. Curriculum vitae;

6. Contracto com a entidade empregadora;

7. Facturas electrdnicas da electricidade;

8. Powerpoints engracados;

9. Fotografias das férias de 2001,

10. Copia de artigos interessantes;

11. Documentos de trabalho do projecto B;

12. Documentos do amigo C, para ajuda no assunto D;
13. Manual do telescdépio E;

14. Ficheiros de um curso de astronomia;

15. Musicado CD F;

16. Video das férias de 2004;

17. Lista telefénica interna;

18. Cépia do diario da republica, artigo G;

19. Regulamento do curso [;

20. Ficheiros do trabalho da unidade curricular J.

Onde colocamos estes ficheiros? Vamos comecar do inicio, apds entrar-mos no windows.

BT
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FIGURA 1 - AMBIENTE DE TRABALHO DO WINDOWS XP A ESQUERDA, E WINDOWS 7 A DIREITA

O Ambiente de Trabalho (Desktop) corresponde a imagem que vemos na Figura 1. Nesse espago
podemos colocar ficheiros, e atalhos que correspondam as aplicacGes que mais utilizamos. No entanto o
ambiente de trabalho ndo é mais que uma pasta especial com uma imagem no fundo, pelo que sera
devidamente tratada no capitulo 3, e como veremos ndo deve ser aqui que se devem colocar os nossos
documentos. A nog¢do de atalho serd também explicada nesse contexto.

A barra em baixo chama-se Barra de Tarefas (Taskbar), e mostra todas as aplicacdes que estdo a correr.
O primeiro botdo Iniciar (Start) serve para iniciar uma nova aplicagdo. Apds clicar no botdo Iniciar
obtemos o menu apresentado na Figura 2.
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FIGURA 2 - MENU INICIAR

Neste menu estdo listadas na zona da esquerda as aplicagbes utilizadas com mais frequéncia
recentemente, acabando com um botdo Todos os Programas (All Programs) que permite visualizar a
lista de todas as aplica¢Oes instaladas, e seleccionar a que se pretende iniciar. Na zona da direita esta
uma lista de pastas e locais, mais fixa, que serd abordada ao longo dos restantes capitulos. De realgar
para ja as pastas a comecar com o nome "My..." no Windows XP, que no Windows 7 estdo em
“Convidado”.

Existe no Windows uma pasta com nome Os Meus Documentos (My Documents), que deve
precisamente conter todos os documentos criados / editados pelo utilizador. O nome da pasta sugere a
sua utilizacdo, e a sua localizagdo esta sempre a mao, tanto no menu Iniciar » Convidado » Os Meus
Documentos (Start » My Documents) como ainda nas préprias aplicacdes havera sempre um botdo para
esta pasta como veremos no capitulo 2. No Windows 7 esta pasta estd associada a um outro conceito,
Biblioteca, de que falaremos mais a frente, podendo o utilizador atingir os ficheiros da pasta Os Meus
Documentos através de Iniciar » Documentos.

Devemos colocar estes ficheiros simplesmente nessa pasta?

e Os Meus Documentos (My Documents)

o Factura electrénica da agua;
Comprovativo de pagamento do imposto de selo;
Relatério de actividades da empresa;
Proposta do projecto A;

Curriculum vitae;

Contracto com a entidade empregadora;
Facturas electrdénicas da electricidade;
Powerpoints engracados;

Fotografias das férias de 2001;

Copia de artigos interessantes;

O O 0O O O O O O O
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Sao apenas 20, pelo que por agora ndo haveria problema, mas naturalmente que se for um utilizador
qgue faca do computador uma ferramenta de trabalho, 20 documentos podem ser produzidos numa sé
semana, e com a multiplicidade de assuntos que acabara por tratar, ou os organiza por pastas ou ndo
sabera facilmente onde os encontrar. Colocar os 20 documentos na mesma pasta, significa que
organizariamos a nossa casa como um so quarto, em que colocariamos todos os objectos "a monte",
tendo de procurar os objectos pretendidos entre todos os objectos, sempre que estes fossem
necessarios. Como facilmente se compreende, esta ndo é uma boa forma de organizar os documentos.

Analisando o nome dos documentos, vemos que este utilizador tem ficheiros de diferentes tipos:
trabalho, contabilidade pessoal, projectos pessoais, e tempos livres. Os tipos de documentos ndo sao no
entanto algo congelado no tempo, evoluem ao longo do tempo, ndo sé porque o computador passara a
ser utilizado em cada vez mais tarefas, como também as actividades e interesses das pessoas variam.
Uma boa estrutura para este utilizador seria portanto a divisdo enunciada acima:

Documentos de trabalho do projecto B;
Documentos do amigo C, para ajuda no assunto D;
Manual do telescépio E;

Ficheiros de um curso de astronomia;

Musica do CD F;

Video das férias de 2004;

Lista telefdnica interna;

Copia do didrio da republica, artigo G;
Regulamento do curso [;

Ficheiros do trabalho da unidade curricular J.

® Trabalho
o Relatério de actividades da empresa;
o Contracto com a entidade empregadora;
o Documentos de trabalho do projecto B;
o Lista telefénica interna;
o Copia do diario da republica, artigo G;

e Contabilidade

O
O
©)

Factura electrénica da agua;
Comprovativo de pagamento do imposto de selo;
Facturas electronicas da electricidade;

® Projectos

O

O O O O O O

® Lazer

Curriculum vitae;

Proposta do projecto A,

Regulamento R do curso |;

Ficheiros do trabalho da unidade curricular J.
Documentos do amigo C, para ajuda no assunto D;
Manual do telescépio E;

Ficheiros de um curso de astronomia;

Powerpoints engracados;
Fotografias das férias de 2001;




o Copia de artigos interessantes;
o Musica do CD F;
o Video das férias de 2004;

Cada pasta pode agora ser subdividida quantas vezes forem necessarias, até se obter a granularidade
desejada.

O nome das pastas e ficheiros deve ser o mais curto possivel, desde que identifique claramente o seu
conteudo, de forma a ter uma leitura rapida. Vamos exemplificar esta questdo: se em vez do texto acima
se tivesse optado por nomes das pastas mais descritivos, obtinha-se a seguinte divisao:

® Documentos relacionados com o trabalho na empresa A
o Relatério de actividades da empresa;
o Contracto com a entidade empregadora;
o Documentos de trabalho do projecto B;
o Lista telefénica interna;
o Copia do didrio da republica, artigo G;
e (Contabilidade pessoal, tanto comprovativos de pagamento como facturas electrénicas
o Factura electrénica da agua;
o Comprovativo de pagamento do imposto de selo;
o Facturas electronicas da electricidade;
® Projectos pessoais, tanto em proposta como em curso ou mesmo finalizados
o Curriculum vitae;
Proposta do projecto A;
Regulamento R do curso [;
Ficheiros do trabalho da unidade curricular J.
Documentos do amigo C, para ajuda no assunto D;
Manual do telescépio E;
o Ficheiros de um curso de astronomia;

O O O O O

e Actividades de lazer e dlbum de fotografias
o Powerpoints engracados;
o Fotografias das férias de 2001,
o Copia de artigos interessantes;
o Mdsicado CD F;
o Video das férias de 2004;

E desaconselhado nomes longos, atendendo a que por um lado levam mais tempo a ler, perdendo a
utilidade que existe na divisdo dos ficheiros, dado que dessa forma sera mais simples a localizacdo de
um ficheiro antigo através de outros métodos, como também perdem generalidade. Isto é, podem
aparecer outros documentos que ndo sejam adequados a nenhuma das pastas, enquanto que com um
nome mais genérico, o ficheiro provavelmente teria uma pasta na qual se enquadrava. Ao criar um novo
documento, como o custo de leitura do nome das pastas pelo utilizador é elevado e muitas das vezes o
tempo é curto, é mais provavel que o novo documento fique gravado num local menos apropriado, e

nesse caso o nome das pastas perde utilidade e significado.




OPERACOES DE EDICAO

Esta é uma tarefa em constante evolu¢do e nunca completamente terminada, ou seja, apds organizados
os ficheiros e pastas, segue-se uma tarefa: organizar os ficheiros e pastas.

Devido a evolugdo natural das pessoas e dos assuntos por elas tratados havera sempre mudangas a
fazer, tanto na localizagdo dos ficheiros e organizagdo das pastas como nos préprios nomes dos ficheiros
e pastas.

No Windows é simples efectuar as seguintes operac¢des, tanto para ficheiros como para pastas:

e  Criar ficheiro / pasta

e Copiar ficheiro / pasta

*  Mover ficheiro / pasta

e Apagar ficheiro / pasta

* Mudar o nome ficheiro / pasta

Vamos exemplificar estas operagdes com a criagdao da organizacdo descrita na secc¢dao anterior. No
entanto, antes de mais, vamos ver quais as opera¢des mais comuns a realizar com o rato:

® mover o cursor do rato para cima de um ficheiro ou pasta;

® um clique (com o botdo da esquerda), sobre um ficheiro, tem o resultado de o seleccionar;

®* um segundo clique sobre um ficheiro ja seleccionado, permite editar o nome;

¢ dois cliques seguidos sem mover o rato, chamado duplo clique, permite abrir o ficheiro numa
aplicagdo, ou a pasta;

e 0o drag-and-drop consiste em colocar o botdo esquerdo do rato em baixo, quando o cursor do
rato se encontra sobre um ficheiro ou pasta, e mover o rato mantendo o botdo pressionado. O

efeito é que o ficheiro ou pasta é "carregado" com o rato. Ao chegar a pasta de destino, pode-se
"largar" o botdo do rato e o ficheiro é movido de uma pasta para a outra.

Estas operagbes estdo por ordem crescente de dificuldade (e geralmente ordem decrescente de
frequéncia de utilizagdo), mas sdo todas muito importantes para que se possa organizar os ficheiros com
comodidade. Caso desconheca uma das operacOes, pratique antes de prosseguir, pedindo ajuda a
alguém caso nao consiga realiza-las.

Estamos agora em condicdes de descrever a forma mais comum de realizar as operacdes enunciadas. No
entanto ndo ha apenas uma forma de executar cada um destes comandos, mas sim varias. Associamos
desde ja os eventos a operagGes de rato e teclado mais comuns:

e (Criar:
o botdo da direita do rato (menu contexto) » Novo (New) » pasta / tipo de documento
e (Copiar:

o drag-and-drop (arrastar com o botdo da esquerda do rato em baixo), largando com a
tecla Shift em baixo (seta +)
o Seleccionar o ficheiro ou pasta » Ctrl+C » abrir a pasta de destino » Ctrl+V
* Mover:
o drag-and-drop do ficheiro ou pasta
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o Seleccionar o ficheiro ou pasta » Ctrl+X » abrir a pasta de destino » Ctrl+V
® Apagar:

o botdo da direita do rato (menu contexto) » Delete

o Seleccionar o ficheiro ou pasta » tecla Delete
¢ Mudar o nome:

o botdo da direita do rato (menu contexto) » Rename

o ap0s seleccionar o ficheiro, clicar no ficheiro seleccionado

Vamos reproduzir estas operacdes de forma a ficar com a organizacdo de ficheiros da seccdo anterior.
Comecamos primeiramente por criar todos os ficheiros da pasta Os Meus Documentos (My Documents),
do tipo Documento de Texto (Text Document):

= )
& My Documents EEx
s s i @\/" » Convidado » OsMeus Documentos
4 . ®) - Organizar +  Incluirnabibliotecs = Partilhar com ~  Nova past
(€12 >R ] ) search Folders (7] -
TR ) 1y pocumenss Tl T Nome Data modificagio  Tipo Tamanho
. - a L] [ Comprovativo doimpost.. 111120101851  Documento de tex. oke
File and Folder Tasks A ;» My Music O My Fctures £l Localizagdes || Contracto com a entidade empregadora Documento de tex.. 0KB
ke - __J ’J 4 Trensferéncias || Capia de artigos interessantes. Documento de tex., 0KB
9 toke anew folder . ; 1" Cépia do dirio da republica, artigo G Documento de tex. 0k
) Publish this falder ta the ™| Factura clectrinica da agua Einprovativg de pagamento do .
i 22| Text Document Spocto de selo A Bibliotecas [ curiiculum Vitae Documento de tex. 0KB
2 shore this folder = | e et Dogument. 4] Documentos || Documentos de trabalho do projecto B Documento de tex. 0K
5 &) Imagens | Documentos do amigo C, para sjuda no Documento de tex. 0B
Relatério de actividades da Proposta do projectn A s y i . E
iy S b &) Msica || Factura electrénica da dgua Documento deter. 0kB
Other Places Text Document B videos || Facturas electrénicas da electricidade Documento de tex. 0KB
Ficheios do trabalho da unidade curicul. Documento deter. 0kB
(@ Deskion B Curriculum Vitse Cortracto com a entidade . BT o 2 R e
= 8 Computador < 2 0
s Text Dacument empregadora P [ Ficheiros de um curso de astronomia ocumento detex
Text Dacument Fotografias das férias de 2001 Documento de tex.. 0KB
i My Camputer . = -
g 5 € Rede || Lista telefénica interna Documento de tex.. 0KB
Nty Network Places [~ Facturas electranicas da Powerpoints engracados
electricidade Text Docment [ Manual do telescopio £ Documento de tex. 0KB
Text Document || Msicado CDF oke Ld
[ s d 0KB
DELElE Manual do telescGpio E Documentos do armigo C, para =, omEEen Agnen®
Text Document ajuda ne assunto D S Proposta do projecto A UXE
et Decumegk Reaulamento do curso1 Documento de tex. 0KB
20 itens
Ficheiros de um curso de Fotografiss das Férias de 2001 I
astronomia Text Document =

FIGURA 3 - PASTA “0S MEUS DOCUMENTOS” APOS CRIAR TODOS 0S FICHEIROS

Na Figura 3 pode-se ver a pasta dos Os Meus Documentos (My Documents) com todos os ficheiros e
mais duas pastas que foram criadas no Windows XP: "My Music" e "My Pictures". Estas como outras
pastas, sdo criadas automaticamente sobre a pasta "My Documents” para colocar ficheiros de
determinados tipos, neste caso de musica e de fotografias, sendo essa a pasta de omissdo que cada
aplicacdo que grava esse tipo de ficheiros. No Windows 7, este tipo de pastas estd ao lado da pasta
Os Meus Documentos, sobre uma pasta com o nome do utilizador, neste caso “Convidado”.

E claro pela lista, que uma organizacao deste tipo ndo é muito vantajosa, dado que para encontrar
um documento, no pior caso tém que se ler os titulos de todos os documentos.

De notar que na zona da esquerda do Windows XP sdo enumeradas possiveis operacdes sobre
ficheiros e pastas. De facto, este é mais um método para organizar documentos, tendo a nossa
disposicdo o comando de que necessitamos, “Criar uma nova pasta” (“Make a new folder”), e que
podemos utilizar para criar as quatro pastas na organizacdo de ficheiros na sec¢do anterior. No
Windows 7 podemos utilizar os comandos disponiveis na barra horizontal superior. Qualquer que
seja a forma utilizada, quando uma pasta é criada, o sistema operativo entra automaticamente em
modo de mudanga de nome.
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& My Documents

EEX
&

File Edt %ew Favorites Tools Help @Cv\ El b Convidado b OsMeus Documentos b < [ 42 ][ Procurar 0s Meu
e Bk~ () Lj: /f\r Search {7 Folders - Organizar v [ Abrir Incluirma biblioteca v Partilharcom v Correio Electrénico. A @
AT = rar— "l = e Nome Datamodificagio  Tipo Tamanho =
S Tianusl 46 Eelescapi E = Dncdumar\ms & Brigo C, para ~ B Ambiente de trabalr | | 13-11-201008:17  Pasta deficheiros
File and Folder Tasks =], TextPorumen: E=| Jdam=ariop £l Localizagaes 1] Comprovativo de pagamento do impost... 11-11-20101&:51  Documento detex 0k8
18 Transferéncias [1] Contracto com a entidade empregadora 111120101851 Decumento d tex.. 0KkB
i Rename this Folder P 4 fias das Férias d )
= icheiros de um curso de: = Fotografias das férias de 2001 || Cépia de artigos interessantes 11-11-201018:51 Documento de tex... 0KB
[y Move this folder = astronomia =| TextDocument ) ) -
= Text Document = i Bibliotecas || Cépia do didrio da repablica, artigo G 11-11-201018:51  Documento de tex 0KB
DY Copy this Folder [ Documentos || Curriculum Vitae 1111-20101851  Documento detex 0KkB
€Y Pubich this folder t | video das féras de 200+ T misca do D F 5] Imagens 5| Documentos detrabalho do projecto B T1-11-20101851  Documento de e oke |
the web =| TextDocument =| Text Documert = 3
£ chere this feldsr = 5 o) Musica || Documentos do amigo C, para sjuda no... 11-11-20101851  Documents de tex. o0ke
o : = Videos ] Factura electrénica da dgua 11120101851 Documento de tex.. 0KB
() E-mai this Folder's files T of
27| Cépia do didri da repiblica, 27| Lstatelefdnicainterra ] Facturas electrénicas da clectricidade 1141-20101851  Documento de tex.. 0KB
W Delete this folder = atino = | TextDocument
= | TextDocument = % Computador || Ficheios do trabalho da unidade curricul...  11-11-201018:51 Documento de tex. 0KB
| Ficheiros de um curso de astronomia 11-11-2010 18:51 Documento de tex. 0KB
Other Places = Ficheios do trabalho da unidads [ Reguiamento da curso 1 € Rede || Fotografias das férias de 2001 11-11-201018:51 Documento de tex. 0ke
=| curicular 1 = | TextDocumert Z
- =5 TedtDec et = 1] Lista telefnica interna 11-11-201018:51 Documento de tex. 0KB
@ o=t 2] Manual do telescépio E 1111-20101851  Documento de tex. 0kB
(5 Shared Dacurents | Copiade artigos interessantes  [27|  Documentos de trabaho do | Masica do COF A P oke
i§ My Computer =| TextDocument =| projecto 3 3
3 & = | TextDocument {11 Powerpoints engragados 114120101851 Documento de tex.. 0kB
3 Hy Nebwerk Flaces Proposta do proiecto A 11-11-20101851  Decumento de tex, (YA
8 —— l Nova pasta Data modificagdo: 13-11-2010 08:17
= Pasta de ficheiros
Details 2 B ‘/’ v

FIGURA 4 - APOS CRIAR UMA PASTA, O WINDOWS ENTRA EM MODO DE ALTERAGAO DE NOME

Pode-se ver também (Figura 4) que os comandos disponiveis ja4 ndo sdo os mesmos, tanto no
Windows XP como no Windows 7. Isto acontece porque estd um ficheiro ou pasta seleccionado,
neste caso a nova pasta, podendo agora existir outro tipo de operagdes.

Seguem-se as operacdes de movimento, em que se pode arrastar o documento para a pasta (folder)
respectiva. Faca este exercicio e teste as diferentes formas indicadas de mover ficheiros.

Deixamos a pasta com mais ficheiros para o fim, para se poderem seleccionar todos os ficheiros, e
moveé-los de uma s6 vez. Para tal clique no primeiro ficheiro, e sempre com a tecla Shift em baixo
clique no ultimo ficheiro. O resultado sera o apresentado na Figura 5.

@& My Documents DEx
File Edt %ew Favorites Tools Help > @C-\ | » Comvidado » OsMeus Documentos » [ %2 ][ Procurar 0s Meus D
G Back - _) 17 ) search (7 Falders V Organizar = )| Abrir  Partilharcom v Imprimir  Cerreio Electronico  Nova pasta =~ 0 @
Address |2} My Documents v B ¢ Favoritas blome Dt modificacsio BN TG Tent
» % ~ B Ambiente de trabalk Contabilidade 13-11-20100820  Pasta deficheiros
3 O = o
File and Folder Tasks (% pusic ( O %) My Pictures £ Localizagoes Lazer 131120100821 Pasta deficheiros
\,—J __J 8 Transferéncias Projectos 131120100810 Pasts deficheiros
[y Move the selected items:
; e . Trabalho 131120100820 Pasta deficheiros
Iy Copy the selected iems % = 4 Bibliotecas || Curriculum Vitae 11-11-201018:51 Documento de tex. 0
(] P”‘l’gihvi:i“‘““id items = 1 = 1 [3 Documentos | ] Documentos do amige C, para sjuda no assunto D 11-L1201018:51  Documento de ter., [
() E-mi the selected tems ] Imagens ___ Ficheiros de um curse de astronomia 11-11-20101851  Documento de tex.. [}
% Delets the selected items :;—_ﬁ = o) Msica | Ficheiros do trabalho da unidade curricular J 11-11-2010 18:51 Documento de tex. 0
= o = ext Do Videos || Manual do telescépio E 11-11-201018:51 Documento de tex. 0
Rt L__ Proposta do projecto A 11-11-2010185] __ Documento detex 0
Other Places :;__ﬁ = . B 1% Computador L_| Regulamento do cursol 11-11-201018:51 Documento de tex. 0
Desktoy = - = -
@ 7 € Rede
(3 Shared Documents = o=
& My Computer = ‘// rabzbo
& My Network Places o
| contabiidade =] Projectos
. L <[ i —
Details
N L | ™\, 7 itens seleccionados Data modificagso: 11-11-2010 18:51 Data de criagdo: 11-11-201018:51
= Tamanho: 0k
I J Lazer - amanho: 0 bytes

FIGURA 5 - SELECGAO DE VARIOS FICHEIROS, COM A TECLA SHIFT

No capitulo seguinte serdo dadas com mais detalhe as diversas formas de seleccionar varios
elementos, sejam esses elementos conteido dentro de um ficheiro, ou mesmo ficheiros ou pastas.
No final ficAmos com os ficheiros agrupados por pastas, facilitando o seu acesso e gravacao.
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% My Documents

=@

Ble Edi UYew Favorites ook Hep @vv\ » Convidado » Os Meus Documentos + [+ ][ Procur 2]
(P back - ) Search Fold - =
Qe >R ] g oers | [FE7] Organizar = Incluir nabibliotecs Partilharcom v Nova pasta = 0 @
= =
ageress [y Documerts ] v|Es = NooE Data modificacsa’ | Tipo Tamanho
¢ Favoritos :
B RS B Ambiente de traball Contabilidade 134130 Pasta de ficheiros

File and Folder Tasks ES j My busic

() Make a new folder
) Publish this folder tathe
wieh

E Localizagdes Lazer Pasta de ficheiros

& Transferéncias Projectos Pasta de ficheiros

Tiahsho, Trabalho

Contabiidade Pasta de ficheiros

|2 Share this folder 4 Bibliotecas

= Documentos

(RN

Projectos Lazer

Other Places

[ Deskiop
() Shared Dacuments
i My Computer

&3y Network places

=) Imagens
& Musica

B videos

18 Computador
€ Rede

Details

4 itens

FIGURA 6 - FICHEIROS ORGANIZADOS POR PASTAS

Esta finalizada a criacao da estrutura de ficheiros e pastas da seccdo anterior, conforme pretendido.
O resultado é ilustrado pela Figura 6.

COMPACTACAO E ARQUIVO

Tendo a estrutura de ficheiros e pastas organizada é conveniente guardar uma copia de seguranga,
para no caso de haver algum problema com o computador, ou acidentalmente apagarmos algum
ficheiro, se poderem recuperar os ficheiros e/ou pastas. Para se realizar esta copia como rotina
(diaria, semanal, mensal, etc, conforme a frequéncia de utilizacdo) convém que o processo seja
simples.

Pode-se facilmente copiar todos os ficheiros e pastas para outra pasta, utilizando o método descrito
na secgdo anterior. No entanto se o fizermos podemos ter os seguintes problemas:

Nao saber qual das estruturas de pastas é a que estd em uso;

Nao saber a data da ultima cépia;

E dificil guardar mais do que uma cépia;

Cada c6pia ocupa o mesmo espaco que o original;

Se forem muitos ficheiros, a copia é demorada, principalmente se a coépia for para um disco
externo (capitulo 3);

e Nao da para enviar por email;

Se ndo houvesse alternativa, passadvamos bem com isso. O mais importante é manter uma cépia
actualizada dos documentos importantes, para evitar perdas. No entanto o Windows permite criar
pastas comprimidas que podem conter estruturas de ficheiros e pastas, mas para o sistema
operativo trata-se de um sé ficheiro. O formato utilizado é o mais conhecido, o zip, existindo
também uma elevada variedade de aplicacées que podem abrir ficheiros compactados. Atendendo a
que o Windows abre e cria estes ficheiros, ndo ha necessidade de utilizar outras aplicacdes.

e Botdo da direita do rato (menu de contexto) » Novo » Pasta comprimida (New »
Compressed folder)

Através desta opcdo € criado um ficheiro, o qual pode ser aberto como se fosse uma pasta normal.
Podem ser movidos ou copiados ficheiros para a pasta tal e qual qualquer outra pasta. No entanto,
no sistema de ficheiros trata-se de um sé ficheiro, muito embora contenha a informacao de todos os
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ficheiros e pastas que 1a forem colocados, permitindo assim que todo o contetido possa facilmente
ser copiado para dispositivos méveis ou enviado em anexo num email.

Vamos fazer uma cépia dos nossos ficheiros:

e (Copiade Seguranga 20101010.zip (Figura 7)

& My Documents TExX [l el
T =
e Bt os Fwores Lo Gep # &=/ » Comidade » OsMeus Documentos » = | 4 || Procurar Os Meus Documentas »|
Bak » ) S D) search [ Fold - =
Qe - @ (F Oseaen [ races Organizar *  Incluir na biblioteca v Partilhar com = Novs pasta =+ 1 @
address | [ My Documents ¥ Be = Nome Dstz modificagio  Tipo Tamanho
N ¢ Faveritos

File and Folder Tasks ( ,}-—h My Music [N My Pictures B Ambiente detraball  |i Contabilidade 13-11-20100821  Pasta de ficheiros

i ./-/ //  Localizagdes Lazer 1341-201008:22  Pasts de ficheiros

@ Publsh thisFolder to the o o 8 Transferéncias Projectos 1311-201008:23  Pasta deficheiros

 web ‘J Trabaho ‘/’ Contabildads, Trabalho 13-11-2010 08:22 Pasta de ficheiros

EQ shars this foder =4 Bibliotecas [T, Cépia de seguranca 20101111 13-11-201008:25  Pasta comprimida... 1K8|

= == [H Documentos
Projectos Lazer
r— cJ =) =
@ Deion E Capia d 20101010 Jj Hsice
opis de seuranca s

& hared Documerts ; el [ videos

i My Computer

89 My Network Places 1% Computador

Details G Rece

L. Sitens
| 1
f

FIGURA 7 - FICHEIRO COMPRIMIDO COM UMA COPIA DE SEGURANCA

E conveniente colocar-se no nome do ficheiro informagdo relevante. No caso das cépias de
seguranga, a data é muito importante, pelo que se aconselha a colocd-la no nome. Agora basta
arrastarem-se as 4 pastas para a nova pasta criada e fica feita a copia, a qual se pode abrir de

seguida, tal como se apresenta na Figura 8.

£ Copia de seguranga 20101010 FEX felfe=d
n s
Fle Edt Yew Favores Tods Help u @U" ) « OsMeus Docum... » Copia de seguranca 20101111 » « | % || Procurar Copia de seguranca 1 0]
Back - () P D seah [ Folders - _
@ L 74 Lj 7 L Organizar » Extrair todos os ficheiros =~ 0 @
Address [ C:\Documents and Settings|GuestiHly Documents\Cépia de sequranga 20101010.p v B — Tipo FE———

Folder Tasks

H O e -

»{ Favoritos

B Ambiente de trabalt Contabilidade

Pasta de ficheires

27 Extract 2l fies Contabildads]  Lazer Projectos  Trabalho 2l Localizagdes Lazer Pasta de ficheiros
18 Transferéncias Projectos Pasta de ficheiros
| Trabalho Pasta de ficheiros
Other Places
4 Bibliotecas
() My Documents [ Documentos
[ Shared Documents i) Imagens
& My Network Places o Musica
B videos

Details

1% Computador

€ Rede

j 4 itens

FIGURA 8 - FICHEIRO COMPRIMIDO ABERTO COMO SE FOSSE UMA PASTA NORMAL

Pode-se ver pelo campo "Address" do Windows XP, e na barra superior no Windows 7, o nome do
ficheiro com a copia de seguran¢a. Embora a pasta tenha uma aparéncia em tudo idéntica a uma
pasta normal (a imagem que representa esta pasta, chamada icone, é ligeiramente diferente), é na
verdade um ficheiro zip, sendo mostrado o contetido do ficheiro.

As copias de seguranga transportam-se normalmente para outros computadores ou dispositivos
que ndo o computador de trabalho, para proteger o trabalho de eventuais acidentes com o
computador. No entanto podemos ter documentos confidenciais que pretendemos evitar a sua

divulgacao acidental.
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Para proteger os ficheiros da copia de seguranca deve-se colocar uma password no ficheiro
compactado, e assim desta forma apenas tem acesso aos ficheiros da cdpia de seguran¢a quem saiba
a password:

o File » Add Password

Add Password X

Password needed

% Eglt;;f password to protect the Compressed (zipped) ? File '‘Comprovativo de pagamenta ... is

pazzword protectad. Pleaze enter the
pazzward in the box belaw.

Pazsword: “ee
Confirm Password: | e e Paszword: | eee Cancel

FIGURA 9 - INTRODUGAO E PEDIDO DE PASSWORD PARA COMPACTAR/DESCOMPACTAR UM FICHEIRO

Pode-se agora navegar nas pastas e ficheiros que estdo no ficheiro zip, mas ao tentar abrir um
determinado ficheiro aparece a dialog a direita na Figura 9 a pedir a password.

A operacdo acima foi feita apenas no Windows XP. O Windows 7 ndo permite colocar passwords
nos ficheiros, mas permite abrir um ficheiro que esteja protegido, se naturalmente o utilizador
conhecer a password. Caso considere esta funcionalidade importante para o seu modo de trabalho,
deve pedir ao administrador para lhe instalar uma aplicacdo de compressao de dados, por exemplo
o 7-zipl

Agora pode copiar com seguranca o ficheiro para outro destino, e no caso de necessitar pode
recuperar ficheiros, ficando em qualquer caso com um arquivo dos ficheiros que em determinada
data eram relevantes para si.

L http://www.7-zip.org
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2. APLICACOES E DOCUMENTOS

Agora que sabemos como manipular ficheiros e pastas, estamos em condi¢des de fazer algo tutil com
esses ficheiros. Sao necessarias por um lado as aplicagdes, que ndo vamos no ambito deste texto
instalar mas apenas utilizar, e por outro lados os ficheiros, que sdo neste caso documentos, onde
reside o conteuido criado e editado através das aplicacdes.

As aplicacoes que vém instaladas com o Windows mais conhecidas dos utilizadores sdo as que
permitem editar cada tipo de ficheiro base:

Calculadora (Calculator) - executa calculos numéricos, como se fosse uma calculadora

Bloco de Notas (Notepad) - edita ficheiros de texto plano (em ASCII)

Paint (Paint) - edita imagens

Wordpad (Wordpad) - edita ficheiros de texto formatado (tamanho de letra, fonte, cor, etc.)
e pode ter imagens ou outros objectos embebidos

A apresentacao de cada uma destas aplicacdes, ndo é o mais relevante neste capitulo, ira certamente
no futuro trabalhar com aplicacbes mais avangadas, mas sim os conceitos introduzidos ao
apresentar cada aplicacdo, que de outra forma seriam conceitos abstractos, sem aplicagdo. Como as
aplicacdes sdo simples, a tarefa de compreensdo de cada conceito fica simplificada, algo que ndo
seria possivel com aplicagdes avancadas devido a terem demasiados pormenores que poderiam
distrair a ateng¢do do leitor do essencial.

CALCULADORA (CALCULATOR)

Um computador € uma maquina generalista. Portanto, o minimo que se pode esperar é que execute
pelo menos as mesmas fungdes que uma maquina de calcular. E precisamente isso que a aplicacdo
Calculadora (Calculator) faz:

e Iniciar » Todos os programas » Acessorios » Calculadora (Start » All Programs » Accessories »

Calculator)
Calculator =0 x| 1 cateutadors  [= ] = [
Edit WView Help Ver Editar  Ajuda
| .
%]
I Backspace CE | c | MC MR MS M+ M-
MC | 7 | 2 | 9 | P | sqrt | — CE [ z v
70 8lof +|=%
w| o | 5| 6| - | %]
alls |6 | w
msl 1|2|3| |‘Ifx| e
we [ o | | <] -| 0 .

FIGURA 10 - APLICAGAO CALCULADORA (CALCULATOR)

A aplicacdo, que esté representada na Figura 10, tem uma dimensdo reduzida, como se fosse uma
pequena calculadora de bolso. Os botdes correspondem aos botées da calculadora, apenas no topo
tem um titulo, trés botdes no canto superior direito, e trés menus Ver|Editar|Ajuda
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(Edit|View|Help). O funcionamento do programa é o que se espera, muito embora se tenha de clicar
nos botdes com o rato, e ndo com o dedo como seria numa calculadora real.

Vamos ver melhor o que fazem os trés botdes do canto superior direito, que estdo presentes em
todas as aplicagdes:

e direita - permite fechar a aplicagdo
® meio - permite maximizar a aplicacdo
e esquerda - permite minimizar a aplicacao

O botdo do meio esta a cinzento, e se se clicar sobre ele ndo acontece nada. Isto porque o botao
esta inactivo (indicado pela cor cinzenta) uma vez que a aplicacdo nao permite redimensionamento,
isto é, tem uma dimensao fixa, e portanto ndo permite a maximiza¢do de forma a ocupar o ecra por
completo.

Clicando no botdo da esquerda a aplicacdo desaparece, muito embora se mantenha na barra de
tarefas (taskbar). Para a chamar novamente basta que se clique na aplicacdo, ou se utilize a
sequéncia de teclas:

e Alt+TAB » troca de aplicacdo

Quanto ha muitas aplicacoes é conveniente trocar de aplicagdo colocando a tecla Alt em baixo e de
seguida carregar na tecla TAB vdrias vezes, mantendo a tecla Alt em baixo até que fique
seleccionada a aplicagdo que se pretende voltar a activar.

Ao clicar no botao da direita a aplicacdo fecha. Em alternativa poder-se-ia também utilizar a tecla
aceleradora Alt+F4. De notar ainda que estes comandos sdo também acessiveis se se clicar no canto
superior esquerdo, em cima da imagem pequena com a calculadora. Tal como ja foi referido, a
imagem que representa uma aplicagdo, chama-se um icone.

Para se abrir a aplicagdo novamente, tem que se repetir o comando acima, ou como ira aparecer
logo na lista de aplicagdes recentemente abertas, bastara fazer agora:

e Iniciar » Calculadora (Start » Calculator)

Quando a aplicacdo abre novamente, os valores anteriores que estavam no display ou na memoria
da calculadora perdem-se. Alias, pode-se inclusive abrir duas calculadoras, como se apresenta na
Figura 11.
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FIGURA 11 - DUAS INSTANCIAS INDEPENDENTES DA APLICACAO CALCULADORA (CALCULATOR)

Cada instancia da aplicacdo é independente da outra. Tanto o mostrador como a memoéria de cada
calculadora tém valores distintos.

O menu Ver (View) permite mudar o modo da calculadora para o formato cientifico (Figura 12).
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FIGURA 12 - FORMATO DE CALCULADORA CIENTIFICA

A calculadora tem agora um maior leque de op¢des, no entanto é apenas outra interface da mesma
aplicacdo, que no modo normal tem uma interface mais simples, disponibilizando as operacgées
mais habituais, mas no seu modo cientifico apresenta todas as possibilidades. E pratica normal
existirem funcionalidades numa aplicagdo muito utilizadas, e outras pouco utilizadas, devendo a
interface maximizar a facilidade de utilizagdo das funcionalidades mais comuns. Na versdo que vem
com o Windows 7, as funcionalidades da calculadora cientifica foram divididas para um modo de
calculadora do programador, tendo também algumas funcionalidades de folha de calculo.

Os utilizadores devem ter em atencdo que, ap0ds utilizarem uma aplicagdo durante algum tempo,
pode haver funcionalidades que ainda desconhecam, e que, se no inicio ndo faziam falta e
possivelmente se estivessem visiveis ndo s6 nido as compreenderiam, como o excesso de opg¢oes
poderia levar a abandonar a aplicacdo, ap6s algum tempo de utilizacdo essas funcionalidades
menos usuais podem revelar-se facilmente compreensiveis e de grande valia. E pois boa pratica
ap0s alguma utilizagdo de uma aplicacdo, reaprender a utiliza-la, consultando a ajuda da aplicacgao.

Nesta aplicacdo a ajuda (Figura 13) estd como habitualmente em toda as aplica¢des, no ultimo
menu, o menu Ajuda (Help).
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FIGURA 13 - AJUDA DA APLICAGCAO CALCULADORA (CALCULATOR)

Se abriu a ajuda de uma aplicacdo, provavelmente ja é utilizador da aplicagdo ha algum tempo. Os
ficheiros de ajuda de uma aplicagdo, no seu formato classico (exemplo do Windows XP) tém uma
zona da esquerda para navegar pela ajuda, e uma zona da direita com o contetido das paginas. A
zona da esquerda tem trés pastas, em que a primeira "Contents" pode-se ver os dois livros, que se
pode abrir e aparecendo um indice de paginas. Na pasta "Index" pode-se procurar por uma palavra-
chave, e na pasta "Search" pode-se procurar no contetido da ajuda. Os novos ficheiros de ajuda
(exemplo do Windows 7), tém uma aparéncia idéntica a paginas web, sendo também cada vez mais
mantidos actualizados online, pelo que é conveniente ligacdo a internet de forma a ver a versao
mais recente.

A consulta da ajuda sera util nas aplicagdes em que gastar tempo a utiliza-las, dado que pode assim
optimizar a sua utilizacdo actual e aumentar a produtividade, ou verificar que nao ha
funcionalidades na aplicacao que lhe estejam a escapar.

Falta agora falar no menu Editar (Edit). Este menu é comum a muitas aplicacdes, e tem neste caso
os dois comandos também comuns a qualquer menu: Copiar | Colar (Copy | Paste). Estes dois
comandos permitem copiar o valor da calculadora e colar o valor previamente copiado para a
calculadora. Atencdo que ndo é o mesmo que utilizar os botdes da memoria da calculadora, uma vez
que com estes comandos, podemos copiar um valor de uma calculadora para outra calculadora,
portanto entre aplicagdes.

Os comandos Copiar / Colar (Copy / Paste) sdo tdo comuns que tém uma tecla aceleradora
operacional em todas as aplica¢des: Ctrl+C e Ctrl+V respectivamente. Experimente a passar um
valor de uma calculadora para outra, de forma a confirmar estas teclas aceleradoras.

Onde ficou o nimero quando passou de uma calculadora para a outra? Ficou guardado na memoria,
num local chamado Clipboard, que guarda informacdo copiada de uma aplicagdo até que seja feito
novo pedido de copia de informacao. Uma vez que o Clipboard tenha informacgao, pode-se colar a
informacdo quantas vezes forem necessarias.
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BLOCO DE NOTAS (NOTEPAD)

Um computador serve também para escrever, como uma maquina de escrever, mas em vez de se
escrever directamente no papel, escreve-se num ficheiro, imprimindo para o papel apenas quando o
documento estiver final e em condi¢des. Desta forma pode-se apagar e corrigir eventuais erros sem
problema.

A aplicacdo do Windows para editar texto puro, é o Bloco de Notas (Notepad). Os ficheiros criados
no capitulo anterior sdo ficheiros de texto, e portanto sio abertos no Bloco de Notas (Notepad).
Pode-se clicar num ficheiro para abrir a aplicacdo que o edita, ou entdo seguir pelo menu:

¢ Iniciar » Todos os programas » Acessorios » Bloco de Notas (Start » All Programs »
Accessories » Notepad)

B Copia de artigos interessantes - Notepad E@@ | Cépia de artigos interessantes - Bloce de notas (= Ech =)

Fle Edt Format Yiew Help Ficheiro Editar Formatar Ver Ajuda

FIGURA 14 - APLICACAO BLOCO DE NOTAS (NOTEPAD)

O resultado deste comando aparece na Figura 14. Repare-se que nos trés botdes do canto superior
direito, agora estdo activos. Significa que se pode maximizar a aplicagdo. Para além disso a aplica¢do
tem uma borda, pelo que é possivel alterar o tamanho da janela que a aplicacdo ocupa. Para tal
basta ir com o rato para uma das bordas, e quando o cursor mudar, fazer uma operac¢do de drag-
and-drop "arrastamento” (com o botdo da esquerda em baixo) a borda da aplicacdo é arrastada até
a dimensao pretendida.

No entanto o Bloco de Notas (Notepad) tem uma diferenca muito grande relativamente a
Calculadora (Calculator): edita documentos. Por esse motivo necessita de um ficheiro para gravar
o documento editado. Na imagem acima abriu-se o ficheiro "Cdpia de artigos interessantes” o que
pode ser feito tanto por duplo clique em cima do ficheiro, como utilizando o comando de menu:

e Ficheiro » Abrir (File » Open)

0 menu Ficheiro (File) é comum a todas as aplicacdes que editam ficheiros, que é a maioria. Este
menu no Bloco de Notas (Notepad) tem os seguintes comandos, todos eles comuns a maior parte
das aplicagoes:

¢ Novo (New) - cria um novo documento (fecha o documento corrente)

e Abrir (Open) - abre um documento existente, seleccionando na lista de ficheiros

e Gravar (Save) - grava o documento actual para o disco

e Gravar Como (Save As) - grava o documento actual mas para outro ficheiro no disco
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e Configurar Pagina (Page setup) - configura aspectos de impressdao do documento
e [mprimir (Print) - envia o documento actual para a impressora
e Sair (Exit) - sai da aplicacado

A dialog de Abrir (Open) e Gravar Como (Save As) sdo quase iguais, uma vez que tém de abrir uma
espécie de explorador do windows para que o utilizador seleccione um ficheiro, tendo disponiveis
as mesmas operagdes do capitulo 1, ficheiros e pastas. Isto porque o utilizador podera
eventualmente sé se lembrar de que o ficheiro tem que estar numa pasta concreta, na altura em que
vai gravar o ficheiro (ou ler), pelo que é provavel que o utilizador tenha necessidade de fazer uma
ou outra operacdo de manipulacdo de ficheiros e pastas. Na Figura 15 apresenta-se o resultado da
operacdo de Abrir um ficheiro a partir do Notepad.
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FIGURA 15 - DIALOG PARA SELECCAO DE UM FICHEIRO PARA ABRIR

No Windows XP, para além da zona principal da dialog, onde se pode navegar nas pastas e
seleccionar o ficheiro que se pretende abrir, tal como ja fizemos no capitulo 1, temos na zona da
esquerda um conjunto de atalhos fixos, dos quais conhecemos o "My Documents”. Os restantes
serdo apresentados no capitulo 3. Estes atalhos permitem rapidamente localizar o ficheiro
pretendido. No Windows 7 esta dialog é praticamente igual ao explorador do windows, excepto a
zona inferior. Na zona inferior de ambas as versdes do sistema operativo, para além do botio para

aceitar a seleccdo, hd a possibilidade de seleccionar o tipo de ficheiro, que é relevante para
aplicagdes que editem mais que um tipo de ficheiro.

Vamos sem mais demora comecar a escrever algum texto. Suponhamos que pretendiamos um
ficheiro com o indice do Essencial do Windows. Comeg¢avamos por escrever o0s textos e
eventualmente acabariamos com o resultado da Figura 16.
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FIGURA 16 - ALGUM TEXTO ESCRITO NO BLOCO DE NOTAS (NOTEPAD)
Experimente escrever o texto acima, e aproveite para verificar o seguinte:

e a0 utilizar o teclado, a letra correspondente a tecla que carregar, vai ser colocada no cursor
(barra vertical a piscar, por vezes horizontal). O cursor é diferente do rato. O rato é uma
seta (embora possa variar), indicando uma posi¢cdo do rato no ecra. O cursor indica uma
posicdo num texto, entre letras.

® se se enganar a escrever, utilize as setas para voltar para tras, e a tecla Backspace para
apagar o caracter antes do cursor, e a tecla Delete para apagar o caracter apds o cursor.

e as teclas PgUp/PgDn sobem/descem uma pagina inteira com o cursor, enquanto que as
teclas Home/End colocam o cursor no inicio/fim da linha actual.

e Se o Ctrl tiver em baixo, as operagdes acima tém uma interpretacdo distinta. Ao andar-se
com as setas, o cursor avanca uma palavra de cada vez, enquanto que com as teclas
Home/End, em vez do cursor ir para o inicio/fim da linha, vai para o inicio/fim do
documento.

e Um clique de rato no documento, reposiciona o cursor na posicao do rato.

Estas funcionalidades ultrapassam largamente a maquina de escrever. No entanto, uma das maiores
vantagens ainda esta por enunciar: o Copiar/Colar (Copy/Paste). J& vimos que com a aplicacao
Calculadora (Calculator) podemos copiar um numero de uma aplicacdo para outra. No entanto seria
interessante podermos no caso do texto, copiar um texto de um lado para o outro. Isso permitiria
que se pudessem reutilizar partes idénticas de um documento em outro, sem ter que as reescrever.

No entanto ndo é interessante duplicar simplesmente o contetido do ficheiro, é mais interessante
seleccionar a parte que se quer copiar, tal como se seleccionou os ficheiros a mover para a pasta
"Projectos” no capitulo 1. Felizmente que isso é possivel, sendo uma operacgdo tdo vulgar que ha
mesmo muitas maneiras diferentes de o fazer.

Seleccionar texto:

e teclado: com o Shift em baixo, utilizar as setas (é valido utilizar também o Ctrl bem como o
PgUp/PgDn e Home/End), ficando seleccionado desde a posicao inicial do cursor, até a
posicao final.

e rato: "arrastar” o rato (drag-and-drop), do inicio/fim para o fim/inicio da seleccdo

¢ rato: duplo clique numa palavra, selecciona a palavra

e Seleccionar todo o texto:

o rato: botdo da direita (menu de contexto) » Seleccionar Tudo (Select All)
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o menu: Editar » Seleccionar Tudo (Edit » Select All)
o teclas aceleradoras: Ctrl+T (Ctrl+A) » esta tecla aceleradora néo é universal

Apés algum texto estar seleccionado, pode-se copia-lo para o clipboard (Ctrl+C), e colar (Ctrl+V)
quantas vezes forem necessarias. Por exemplo, experimente a copiar a primeira linha varias vezes
no final do texto, conforme a Figura 17.
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FIGURA 17 - EDICAO DE TEXTO, APOS OPERAGAO DE COPIAR/COLAR (COPY/PASTE)

A linha repetida foi copiada uma vez e colada varias vezes, ndo tendo portanto sido necessario
grande custo para o fazer. Pode-se também utilizar a seleccdo para apagar o texto seleccionado,
utilizando as teclas Backspace ou Delete, ou entdo para mover a seleccao, se se Cortar (Cut, Ctrl+X),
e Colar (Paste, Ctrl+V). A operacao de Cortar (Cut) copia a seleccdo para o clipboard mas apaga-a
também, de forma a que o texto, ao ser colado noutro local, seja na verdade movido e ndo copiado.

Uma das principais vantagens do texto digital sobre uma versdo em papel, é a possibilidade de
procura. O Bloco de Notas (Notepad) tem essa possibilidade no menu Editar » Localizar (Edit »
Find), abrindo a dialog da Figura 18.
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FIGURA 18 - UTILIZACAO DA PROCURA NO BLOCO DE NOTAS (NOTEPAD)

Ao colocar o texto "Windows" na procura, a primeira ocorréncia foi identificada imediatamente,
podendo continuar para a préxima ocorréncia. Nao houve necessidade de ler todo o texto com
atencdo para procurar a palavra, nem consultar um indice remissivo.
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Esta vantagem pode ainda ser estendida, com a possibilidade de troca de um texto por outro, o
comando Editar » Substituir (Edit » Replace), conforme a Figura 19.
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FIGURA 19 - UTILIZACAO DA SUBSTITUICAO DE TEXTO

Neste caso pretende-se trocar "Windows" por "MS Windows". Na imagem a primeira ocorréncia ja
foi trocada, e foi encontrada a segunda ocorréncia de "Windows". A dialog poderia inclusive fazer
todas as trocas Substituir tudo (Replace All), sem perguntar nada. Desta forma é possivel mais
tarde corrigir algum erro numa sigla ou numa palavra, com um esfor¢o que nao é dependente da
dimensao do texto a corrigir.

Falta ainda uma funcionalidade horizontal a todas as aplicagdes que editam documentos, e de
importancia ainda superior a procura e substituicdo, dado que é aplicavel ndo apenas a aplicacoes
de edicdo de texto, mas a todas as aplicacGes de edicdo: possibilidade de voltar para tras de forma
a corrigir algum erro de edicdo. No menu Edit » Undo (Ctrl+Z) pode-se eliminar a tltima operac¢do
efectuada. Esta operacdo estd mais desenvolvida em aplicagdes mais avancadas, permitindo andar
para tras varios passos, até a ultima vez que se gravou o documento, mas nas aplica¢gdes abordadas
neste capitulo apenas poderd anular a ultima operacio.

0 menu Formatar (Format) tem um comando importante especifico do Bloco de Notas (Notepad):
ligar/desligar o Word Wrap. Se estiver ligado, quando uma linha tiver um comprimento maior que a
largura da aplicacdo, a linha continua na linha seguinte. Se tiver desligado, a linha continua para a
direita, e uma scroll bar horizontal é mostrada na zona de baixo. Normalmente é preferivel ter o
Word Wrap ligado, para que exista apenas uma scroll bar vertical. No menu Formatar » Fonte
(Format » Font) pode-se alterar a fonte da letra a utilizar pela aplicacdo, mas desta dialog falaremos
na aplicacdo Wordpad que permite formatar texto.
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PAINT (PAINT)

Utilizdmos o computador para fazer contas e escrever texto, falta agora um importante tipo de
documento: imagem. E possivel construir uma imagem, ou editar uma obtida com uma maquina
fotografica ou um scanner. Cada imagem ndo é mais que um documento, mas em vez de texto
contém uma imagem. O Windows pode visualizar imagens directamente, mas para a editar temos
de abrir uma aplicacdo. A aplicacdo que vem de raiz com o Windows para edicdo de imagens é o

Paint (Figura 20).

e Iniciar » Todos os programas » Acessorios » Paint (Start » All Programs » Accessories » Paint)
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FIGURA 20 - APLICAGAO DE EDICAO DE IMAGEM PAINT

Acabada de abrir a aplicacdo podemos ver que desta vez o nome do documento no titulo esta em
Sem Titulo (untitled). A maior parte das aplicacdes que edita documentos se se abrir sem um
documento associado cria um novo documento na memodria, que nao estd ainda associado a
nenhum ficheiro. Quando o documento for gravado, o utilizador tem de indicar um nome de ficheiro
e pasta onde o documento ira ficar.

Na diferenca de interfaces do Paint entre o Windows XP e o Windows 7 é notdria a passagem do
estilo menu e barra de ferramentas, para um estilo de agrupamento de barras de ferramentas, cujo
aspecto ¢ alterado conforme o espaco disponivel. Este novo estilo foi utilizado na maior parte das
aplicagdes da Microsoft mais recentes. Embora os comandos tenham permanecido com
funcionalidades idénticas, torna-se mais complexa a tarefa da identificacdo dos comandos, pelo que
iremos fazer referéncia aos comandos da versdo do Windows XP.

Os menus File | Edit | View | Help tém os mesmos comandos e mais alguns que no Bloco de Notas
(Notepad), excepto o menu Help que é igual. H4 no entanto agora dois menus especificos Image |
Colors. Através dos menus da aplicacdo o utilizador consegue chegar a todas as funcionalidades. A
descricdo completa dos comandos no Paint tornar-se-ia no entanto cansativa devido ao elevado
numero de funcionalidades, e pouco produtiva dado que um utilizador ao iniciar-se no Paint nido
iria fixar todos os comandos.

As barras de ferramentas sdo Uteis precisamente numa situacdo em que ha muitos comandos, sem
existir uns muito mais frequentes que outro, como é o caso do Paint. Cada botdo é no entanto
apenas um atalho relativamente a utilizacdo dos menus, mas sao imprescindiveis neste caso, ndo sé
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porque o tempo de aprendizagem fica muito reduzido, como é mais rapido clicar num botao que
seleccionar um comando de menu.

Vamos deixar o utilizador confirmar a aprendizagem rapida, deixando-o explorar as diferentes
funcionalidades, de forma atentar obter uma imagem parecida com a da Figura 21.
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FIGURA 21 - IMAGEM DE TESTE CONSTRUIDA

Agora que testou o lapis, inserir texto na imagem, fez poligonos e rectdngulos, preencheu uma zona
com uma cor, utilizou um spray, e até copiou um rectangulo da imagem para outro local, em que
necessitou de utilizar o clipboard (Copiar / Colar), mas com uma parte da imagem em vez de ser
uma parte do texto, vamos gravar a imagem. A dialog de gravacao (Figura 22) é idéntica ao do Bloco
de Notas (Notepad).
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4 Ocultar pastas

FIGURA 22 - DIALOG DE GRAVAGAO DE UMA IMAGEM

A pasta de omissdo é As Minhas Imagens (My Images), de forma a facilitar a organizacdo do
utilizador, mas evidentemente que pode sempre escolher outro local. O campo na zona inferior da
dialog “Guardar com o tipo” (Save As Type) contem varias opg¢des, mas na figura esta escolhido PNG.
Isto acontece porque o Paint edita um documento imagem, no entanto uma imagem pode-se gravar
de diversas formas. O Paint suporta os formatos de imagem mais comuns, o utilizador apenas tem
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que optar por um. O formato base de windows é o Bitmap (BMP), mas o formato optado PNG utiliza
normalmente menos espago no disco. A imagem gravada apresenta-se na Figura 23.

FIGURA 23 - IMAGENS PRODUZIDAS PELO PAINT (PAINT)

O leitor pode agora perguntar-se: mas e este documento que estou a ler? Como é que foi construido
com a imagem da aplicacdo? Foi desta forma, com o Paint?

Ora o Windows tem uma interface grafica, pelo que se vemos uma imagem gréafica, podemos estar
também interessados em extrair o que vemos e colocar numa imagem que podemos editar. E
precisamente para isso que existe a tecla PrtScr (abreviatura de Print Screen), para obter a imagem
a ser visualizada tanto na janela activa, como em todo o ecra:

e PrtScr » captura todo o ecra visivel
e  Alt+PrtScr » captura a janela activa

Foi desta forma que as imagens neste texto foram capturadas. No entanto ainda nos falta dizer para
onde as imagens foram: para o clipboard. Apés utilizar uma das formas de capturar o ecrd, é como
se tivesse feito uma accdo de "Copiar" numa aplicacdo de imagem, falta agora fazer o "Colar".
Significa também que qualquer aplicacdo de edicdo de imagens pode na verdade capturar as
imagens do ecri e edita-la.

Faga por exemplo como se mostra na Figura 24.
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FIGURA 24 - IMAGEM CAPTURADA DE UMA APLICAGAO, E EDITADA
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WORDPAD (WORDPAD)

Terminamos a nossa ronda sobre as aplicacdes base voltando ao texto. O Bloco de Notas (Notepad)
consegue substituir com vantagem a maquina de escrever, no entanto os documentos que vemos
hoje em dia tém formatacdes de letra distintas numa s6 pagina, colocando titulos de capitulos e

sec¢des mais realcados, palavras no texto a Bold ou a [talico, por vezes utiliza-se outra cor que nao o
preto, efeitos de sombreado, imagens inseridas, etc.

O Bloco de Notas (Notepad) nao nos permite construir um documento deste tipo. Edita apenas

texto. Para editar um documento com formatagao, podendo incluir imagens, a aplicagdo base do
Windows é o Wordpad (Figura 25).
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FIGURA 25 - EDICAO DE TEXTO FORMATADO: WORDPAD

Tal como o Bloco de Notas (Notepad), o Wordpad permite escrever texto. Vamos abrir o ficheiro
escrito anteriormente no Bloco de Notas (Notepad), obtendo o resultado apresentado na Figura 26.
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FIGURA 26 - FICHEIRO DE TEXTO NAO FORMATADO NO WORDPAD

Para abrir o ficheiro tem de se alterar o tipo de ficheiro. Tal como nas imagens, para documentos
com texto formatado ha muitos tipos de ficheiro. O formato RTF que vem de omissdo é o mais
portavel entre aplica¢cdes que permitem editar este tipo de ficheiros, mas como o nosso documento
estd em texto (TXT), tem que se seleccionar esse tipo de ficheiro para o poder ver e depois escolher.

No menu View pode ligar todas as barras de ferramentas, que sdo relativamente intuitivas:
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e alteracdo de fonte e tamanho da letra » diz respeito ao texto seleccionado ou a posicdo do
cursor

e botdes de: Bold; Italico; Underscore; cor » também relativamente ao texto sublinhado

e Justificacdo a esquerda / centro / direita e bullets » diz respeito a linha actual, ou linhas
seleccionadas

No entanto ha também a possibilidade de se inserir uma imagem. Como? Simplesmente utilizando o
clipboard. Faz-se a copia de uma imagem para o clipboard, e cola-se no Wordpad, ap6s ter colocado
o cursor na posicdo pretendida. Tente construir o documento apresentado na Figura 27.
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FIGURA 27 - DOCUMENTO DE TEXTO FORMATADO E COM UMA IMAGEM INSERIDA

Ao gravar o documento, se gravar em modo TXT (o original), perde a formatacdo e imagens, pelo
que tem de escolher outro formato, por exemplo RTF (Rich Text Format). No final fica com outro
ficheiro com 0 mesmo nome mas de outro tipo, como se pode ver na Figura 28.
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FIGURA 28 - PASTA ONDE FOI GRAVADO O FICHEIRO RTF

Note ainda que o Wordpad permite inserir ndo apenas texto, mas qualquer objecto que possa
inserir em outras aplicacdes de processamento de texto, com o menu Inserir » Objecto (Insert »
Object). Os objectos disponiveis dependem das aplica¢des que estdo instaladas.

Vamos agora imprimir o documento criado. Para tal é sempre conveniente ver como o documento
fica, antes de gastar papel e tonner na impressora. O comando Ficheiro » pré-visualizar (File »
Print preview), comum em todas as aplicagcdes que permitem imprimir, permite fazer uma previsao
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de como ficard o documento (Figura 29). Se necessario pode-se acertar as margens e outras
configura¢des em Ficheiro » Configurar pagina (File » Page setup).

dpia de artigos interessantes - WordPad | k= | Copia de artigos interessantes - WordPad E=NEcE |
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Paginal

FIGURA 29 - PRE-VISUALIZAR A IMPRESSAOQ

Experimente fazer os ajustes necessarios e depois carregue em Imprimir (Print) ou entio utilize o
comando Ficheiro » Imprimir (File » Print), sendo aberta a dialog de impressao da Figura 30.
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FIGURA 30 - DIALOG DE IMPRESSAQ

Ao imprimir, o utilizador tem que escolher a impressora para a qual pretende imprimir. No caso da
figura seleccionamos no Windows XP uma impressora pdf9952, que é uma aplicagdo que em vez de
imprimir para papel, cria um ficheiro PDF (Portable Document Format). Os ficheiros PDF podem ser
visualizados facilmente em qualquer computador, podendo o tipo de documento original ser
qualquer um. Desde que uma aplicacdo consiga imprimir, conseguird através da impressora gerar
ficheiros PDF. Para o PDF ser visualizado, é necessario instalar apenas o PDF Reader (gratuito). E
portanto um tipo de documento parecido com o papel, mas na forma digital. No Windows 7
seleccionamos a impressora Microsoft XPS Document Writer, que faz o0 mesmo que o pdf995, mas
gera ficheiros XPS (XML Paper Specification), um tipo de documento com uma filosofia semelhante a
do PDF.

Zhttp://www.pdf995.com/
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Ap6s a escolha da impressora deve-se carregar no botdo Preferéncias (Preferences) para escolher
as opg¢des da impressora. Cada impressora pode ter opcdes distintas. Por exemplo, se tiver cor,
podemos querer imprimir sem cor, ou imprimir frente-e-verso. O resultado de imprimir em PDF ou
XPS é a criagdo de um ficheiro que vemos na Figura 31.
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FIGURA 31 - VISUALIZAGAO DOS DOCUMENTOS IMPRESSOS PARA PDF E XPS
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3. EXPLORADOR DO WINDOWS

Agora que manipula ficheiros e pastas, bem como aplicagbes e documentos, nada mais de
importante lhe resta aprender para poder fazer uma boa utilizacdo do sistema operativo. No
entanto ha alguma informacdo que necessita saber de forma a poder melhorar a sua utilizagdo do
windows, nomeadamente no explorador do windows, a aplicacdo que utiliza para manipular
ficheiros e pastas. Tal como com qualquer aplicacdo deve apds utiliza-la durante algum tempo,
reaprender a utiliza-la, para eventualmente tirar melhor partido das suas funcionalidades menos
6bvias. E o que vamos fazer com o explorador do windows.

EXPLORADOR DO WINDOWS REVISITADO
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FIGURA 32 - EXPLORADOR DO WINDOWS

Na Figura 32 apresenta-se novamente o Explorador do Windows. A zona de exploragdo (a
esquerda) do explorador do windows no Windows XP, apresenta um conjunto de acgdes e
informacao sobre a pasta a visualizar, ou sobre o item seleccionado. Sem objecto nenhum
seleccionado ha trés possibilidades de ac¢des:

e (Criar uma outra pasta;
e Publicar a pasta na web;
e Partilhar esta pasta.

Destas trés acgdes, duas estdo igualmente disponiveis no Windows 7 na barra superior horizontal.
Apenas nao foi dado destaque a publicacdo na web. Ja conhecemos a criacdo da pasta. Em relagio ao
ultimo comando, a partilha de uma pasta, pode ser feita tanto para utilizadores do mesmo
computador, como para utilizadores na mesma rede interna, constituindo uma alternativa a copiar
os ficheiros para discos externos ou transferi-los por email.

0 segundo bloco lateral esquerdo tem uma lista de locais fixa onde se pode ir rapidamente:

e Ambiente de Trabalho (Desktop) » pasta com os ficheiros no ambiente de trabalho;

e Documentos Partilhados (Shared documents) » pasta como os meus documentos mas
comum a todos os utilizadores do computador;

e 0 meu computador (My computer) » pasta com todos os dispositivos de memodria
secundaria do computador (discos rigidos)
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No Windows 7 pode haver alguma edicdo dos atalhos disponibilizados na zona de exploragdo
esquerda.

O terceiro bloco tem informacdo detalhada sobre o objecto seleccionado ou a pasta a ser
visualizada. Essa informacao no Windows 7 é colocada na zona inferior do explorador, podendo o
utilizador alterar a dimensao dessa area.

BIBLIOTECAS NO WINDOWS 7

Uma diferenca substancial do Windows 7 relativamente aos ficheiros é o conceito de Biblioteca.
Uma Biblioteca é um conjunto de uma ou varias pastas. Na Figura 32Figura 32 o explorador do
Windows 7 esta num local “Bibliotecas » Documentos”, a qual inclui 2 localiza¢des. Podemos ver na
Figura 33 a lista de pastas associadas, podendo naturalmente editar essa lista, e claro, criar novas
bibliotecas.

T — =

Alterar a forma como esta biblioteca retine o contetido

A

FIGURA 33 - PASTAS ASSOCIADAS A BIBLIOTECA “DOCUMENTOS” NO WINDOWS 7

Os ficheiros e pastas ndo estao no entanto em dois locais, ao contrario do que possa parecer, estdo
apenas na pasta de origem. Sao acedidos através da pasta em que estdo, e também da biblioteca (ou
bibliotecas) a que pertencerem. Por outras palavras, quaisquer operacdes que se facam sobre o
ficheiro sdo reflectidas em todos os locais em que este possa ser acedido, pois trata-se de um sé
ficheiro.

BARRA DE ENDERECO (ADDRESS)

Vamos agora ver melhor a barra de ferramentas, a zona de cima do explorador do Windows (Figura
34).
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FIGURA 34 - BARRA DE ENDERECO DO EXPLORADOR DO WINDOWS

8 My Documents BEx [ESEE=E SR
Ele Edit Yiew Favorites Tools Help e @\J’l | + [Convidada [+ 05 Meus Documentos » = M,H Pro )
e .migoDesktop .
¢ 5 ) Organizar v Incluir asta - @
(€ > R 7 ) search Faders [T17]- g A Mo Misics fl @
. 4 Baribieniie de lahally modificagio Tipo Tamanho
Address | (L) my Documents v Go R Favontas mbtente ce frabatho

Pasta de ficheiros
Pasta de ficheiros
Pasta de ficheiros
Pasta de ficheiros

Pasta comprimida. 1K

33



A barra Endereco (Address) do explorador do windows tem o endere¢o onde a pasta actual se
localiza. No Windows XP a pasta Os Meus Documentos (My Documents) é uma pasta que vem de
origem no sistema, sendo mostrado apenas o seu nome. Caso contrdrio, seria mostrada toda a
sequéncia de pastas desde a raiz do disco rigido, até aquela onde a pasta se localiza. Esta barra é um
controle de seleccdo, e ao abri-lo podem-se ver outras pastas para onde se pode navegar facilmente.
Caso pretenda pode também escrever o nome da pasta para onde pretende ir, bem como todas as
pastas anteriores desde a raiz do disco rigido, e o explorador "salta" para essa pasta.

0 Windows 7 niao mostra o caminho completo no caso de ndo caber, mostra apenas as pastas
ascendentes mais perto. No entanto em vez de ter apenas um controle de seleccdo, tem varios, um
em cada pasta. Desta forma o sistema permite ao utilizador, em cada pasta, mover para uma sub-
pasta que esteja nessa pasta. Na Figura 34 abriu-se a pasta “Convidado”, que contém a pasta “Os
Meus Documentos”, podendo-se ver e mover todas as pastas que estao de baixo da pasta raiz deste
utilizador.

Os botdes em cima da barra de endereco (address) permitem por um lado navegar, e por outro
alterar a visualizacdo do explorador do windows. O primeiro botdo "Back” permite voltar para as
ultimas pastas onde se esteve, enquanto que o botdo com a seta para a direita, permite recuperar a
pasta original, ap6s a utilizacao do botdo "Back". Ja o botdo com a seta para cima, permite ir para a
pasta que contem a pasta actual, tendo este botdo sido descontinuado no Windows 7, ja que o
utilizador pode simplesmente clicar nessa pasta na barra de enderecos (address). Os botdes mais a
direita sdo atalhos para visualizagcdo do explorador, cuja localizacdo é diferente nos dois sistemas
operativos, mas deles falaremos mais a frente.

MENUS

Os menus do explorador do Windows 7, estdo ocultos por omissdo, mas mesmo nesse caso pode-se
aceder utilizando a tecla Alt. O menu Ficheiro (File) permite fazer o que ja se faz com o menu de
contexto (botdo direito do rato). O menu Editar (Edit) permite fazer as operacdes habituais de
edicao, Copiar / Colar (Copy / Paste), tendo também uma operacao Anular (Undo) que permite
voltar para tras numa operacao sobre ficheiros ou pastas. Estas op¢des sao idénticas as aplicacdes
que ja vimos, como por exemplo o Wordpad, fazendo agora estes comandos mais sentido. No
entanto neste caso (Explorador do Windows) em vez de se seleccionarem partes de um documento
para copiar / mover / apagar, seleccionam-se ficheiros ou pastas. Em sintese, hd apenas um
conceito a reter, manipulacdo de objectos, sejam eles ficheiros e pastas, ou sejam eles elementos de
um documento de imagem ou texto.

No entanto muita atencdo para as operacdes com ficheiros e pastas. Pode-se inadvertidamente
apagar ficheiros que podem ter levado horas ou mesmo dias a serem feitos, pelo que a utilizagdo do
Anular (Undo) com operacgdes de ficheiros e pastas deve ser encarada como ultimo recurso, e nao se
utilizar sistematicamente.

O menu Ver (View) do windows XP (Organizar no Windows 7) tem as op¢des de visualizacdo do
explorador do Windows (Figura 35). Pode-se ligar/desligar as barras de ferramentas, abrir/fechar
as barras de exploracdo, e seleccionar a forma como pretendemos que sejam mostrados os
elementos da pasta, que neste momento estd em Icones grandes (Tiles) no Windows XP e em
Detalhes (Details) no Windows 7. Pode-se ainda arrumar os elementos da pasta por nome ou data.
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FIGURA 35 - OPCOES DE VISUALIZACAO DO EXPLORADOR DO WINDOWS

Vamos trocar entre si a forma como sdo mostrados os ficheiros e pastas em cada uma das versdes
do sistema operativo. O resultado é apresentado na Figura 36.
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FIGURA 36 - TROCA DE OPCOES DE VISUALIZAGAO DO EXPLORADOR DO WINDOWS

Na forma de visualizacdo Detalhe (Details) cada ficheiro ou pasta esta numa linha, existindo varias
colunas com informacao relevante sobre cada ficheiro ou pasta: tamanho do ficheiro; tipo do
ficheiro; data de modificacdo. Se se quiser alterar a informacdo existente, pode-se também
configurar. O Windows 7 permite mais op¢des de visualizacdo, nomeadamente na escolha da

dimensao dos icones, o que pode ser util para utilizadores que trabalhem com resolu¢ées muito
elevadas e tenham problemas de visao.
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FIGURA 37 - CAMPOS A VISUALIZAR NO MODO DETALHES DO EXPLORADOR DO WINDOWS
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Com a dialog da Figura 37 pode-se seleccionar a informacdo a visualizar no explorador do windows,
e por que ordem.

PAINEL DE EXPLORACAO E PROCURA

Em vez de na zona de exploragdo no Windows XP ( a esquerda) estarem comandos, o que pode ser
visto como desperdicio de espagco uma vez que esses comandos podem ser executados facilmente
de outras formas, pode-se seleccionar para a barra de exploragao:

e Pastas (Folders): uma arvore de pastas

e Procura (Search): procura nos ficheiros

e History: lista de ficheiros abertos por datas

e Favoritos (Favorites): lista de atalhos favoritos colocados pelo utilizador

Destas as mais importantes sdo as duas primeiras, merecendo dois botdes na toolbar, porque por
um lado permitem facilitar ndo s6 a navegacdo como também a localizacdo do utilizador na
hierarquia de pastas, e por outro lado permitem a procura de um ficheiro ou pasta tal como num
documento de texto se procura por uma palavra. No Windows 7 esta zona ja vem ocupada de
omissdo com o painel de navegacdo que consiste numa arvore de pastas, mas organizada por pastas
do sistema: favoritos, bibliotecas, computador, rede. A procura foi considerada tdo importante que
foi colocada ao lado da barra de enderecos, e esta sempre disponivel.

Vamos comegar pelo Windows XP (Figura 38):
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FIGURA 38 - ARVORE DE PASTAS E PROCURA NO WINDOWS XP

Pode-se ver (Figura 38 a esquerda) que com a opc¢do Pastas (Folders) sabe-se onde estd a pasta que
estamos a ver, e com pouco espaco sabemos informacio detalhada dos ficheiros nessa pasta. Pode-
se ainda ver que a pasta Lazer esta sobre a pasta Os Meus Documentos (My Documents). Por outro
lado o endereco completo é dado no campo Endereco (Address), desde do disco “C:\”. Podemos
através deste endereco saber onde esta fisicamente a pasta Os Meus Documentos (My Documents),
sobre uma directoria Guest (o utilizador desta sessdo), o qual esta debaixo de uma directoria
“Documents and Settings” no disco “C:\”. No final todas as pastas tém de estar num disco.

Como um exemplo de uma procura, suponhamos que pretendemos ter a lista de todos os ficheiros
com "artigos" no nome. A imagem da Figura 38 a direita é o resultado de se efectuar a procura. E
fornecida uma lista de ficheiros que correspondem ao resultado da procura. Esta funcionalidade é
mais poderosa que o Localizar (Find) no Bloco de Notas (Notepad), podendo fazer restri¢des por
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datas, entre outras op¢des. No entanto acabara por ser ineficaz no caso do utilizador nao se lembrar
do titulo utilizado no ficheiro que procura.

Experimente também a utilizar o History e o Favoritos (Favorites), que embora menos relevantes
alguns utilizadores fazem boa utilizagdo destas duas vertentes. No caso do History, permite que um
utilizador encontre facilmente um documento através do periodo em que esteve a trabalhar nele, e
ndo através do nome. A procura também tem esta possibilidade, mas o History organiza os ficheiros
por tempo. Com os Favoritos (Favorites) pode-se construir uma hierarquia de atalhos paralela a
hierarquia de pastas no disco.

Vamos agora ver o Windows 7:
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FIGURA 39 - EXPLORADOR SEM PAINEL DE NAVEGAGCAO E RESULTADO DA PROCURA NO WINDOWS 7

Na Figura 39, retirou-se no Windows 7 o painel de navegacdo lateral, libertando espaco, e
procurou-se por ficheiros com “artigos” tal como no Windows XP. Cada utilizador deve explorar as
opcodes do seu sistema operativo de forma a tirar o melhor partido dele, devendo colocar as
ferramentas mais importantes para si no local de maior acesso. A facilidade de navegacao na
estrutura de passa bem como a procura pode aumentar a produtividade diminuindo o tempo gasto
a localizar ficheiros.

O MEU COMPUTADOR (MY COMPUTER)

Para além da pasta Os Meus Documentos (My Documents), hd também algumas outras pastas
especiais cujo acesso é facilitado ndo s6 no explorador do windows, como nas dialogs de abertura e
gravacao de ficheiros. Vamos ver as pastas Ambiente de Trabalho (Desktop) e O Meu Computador
(My Computer), comecando por esta ultima (Figura 40).
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FIGURA 40 - PASTA COMPUTADOR NO WINDOWS XP E WINDOWS 7

Esta pasta do computador é talvez a mais importante para compreender que os ficheiros e pastas
estdo na realidade todos guardados em discos. 0 Windows XP, neste caso, tem um disco rigido (C:),
um leitor de CDs (D:), e um disco removivel (F:). E também comum identificar o disco rigido através
da letra da drive correspondente, neste caso C:, ou drive C. O disco removivel (na drive F:) esta
presente porque foi ligado ao computador uma pen USB. Para este disco podem agora ser copiados
ficheiros, que ficam na pen USB e ndo no computador, permitindo por um lado mover facilmente
ficheiros de um computador para outro, e por outro lado fazer copias de seguranca, e coloca-las
num local seguro. No Windows 7 existem duas unidades de disco rigido, ndo existindo leitor de CDs,
e um disco removivel (E:) que na verdade é a mesma pen USB que foi ligada no Windows XP. O
disco rigido costuma corresponder a drive C: por razdes historicas, pois inicialmente, na criacdo do
windows, alguns computadores nem tinham disco rigido, funcionando a base de disquettes que
ocupavam as drives A: e B: . Quando os computadores comecaram a ser dotados de disco rigido,
este ocupou a préxima letra disponivel C:, e por essa razdo mantém-se até hoje a tradigdo do disco
rigido ser acessivel através da drive C: . A utilizacdo dada a partir desta letra é geralmente op¢ao
dos fabricantes para cada computador. Por exemplo em relacdo a Figura 40, no Windows XP a drive
D: foi destinada ao leitor de CD, enquanto no Windows 7 a drive D: corresponde a uma particdo do
disco rigido destinada pelo sistema para backup, ou seja neste ultimo caso (que é comum) o espago
do disco rigido foi dividido em mais do que uma particdo. As particdes destinam-se geralmente a
fins especificos (neste caso backup) como por exemplo os sistemas de dual boot, que podem
funcionar com uma particdo para windows e outra para linux. As particdes sdo criadas ao instalar
(ou reinstalar) o computador e obedecem depois as limitacdes fisicas de disco destinado a cada
uma.
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AMBIENTE DE TRABALHO (DESKTOP)

A pasta Ambiente de Trabalho (Desktop), como podemos ver na Figura 41, sdo os atalhos que estdo
no ambiente de trabalho, mas neste caso visualizados numa forma normal do explorador do
windows:
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FIGURA 41 - AMBIENTE DE TRABALHO (DESKTOP) VISUALIZADO NO EXPLORADOR DO WINDOWS

Na verdade sdo apenas atalhos, ou seja, uma referéncia para o verdadeiro programa ou ficheiro,
com o icone igual ao original, acrescentando uma seta no canto inferior esquerdo. Os atalhos
presentes sdo apenas aplicacdes, que é o que faz mais sentido, no entanto pode haver atalhos tanto
para ficheiros como para pastas. Com atalhos é possivel um ficheiro ou pasta “estar” (o que na
realidade esta é uma referéncia, que permite aceder facilmente ao local do verdadeiro ficheiro ou
pasta) em mais que um local ao mesmo tempo, mas se tal for muito utilizado, é sinal que a
organizacdo de ficheiros e pastas é deficiente, e necessita de reformulacdo. A boa utilizagdo para os
atalhos é realmente para o acesso as aplicacdes utilizadas mais frequentemente, que vemos aqui na
pasta Ambiente de Trabalho (Desktop). Os programas relativos as aplicacdes estdo numa pasta de
instalacdo a que um utilizador que ndo seja administrador ndo deve aceder, para evitar
acidentalmente apagar ficheiros e corromper a aplicagao.
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4. CONFIGURACAO DO WINDOWS

Agora que ja utiliza o0 Windows, vamos falar sobre assuntos menos importantes mas por vezes com
impacto na produtividade ou pelo menos no gosto na utilizacdo do windows: configuracdo do
windows, muito embora para um utilizador que nido seja administrador o melhor termo sera
customizacio do windows.

Primeiramente é conveniente referir que ha tarefas que o utilizador normal ndo pode nem deve
fazer, tém de ser feitas por um administrador, como por exemplo a instalacdo de aplicacoes,
configuracdes de redes e impressoras, etc. Essas tarefas sdo tarefas de administracdo. O utilizador
normal tem no entanto ao seu dispor um vasto leque de op¢des de customizagdo do windows, de
forma a personalizar a sua conta de acordo com os seus gostos pessoais e seu método de trabalho. E
sobre essas opg¢oes que incide o presente capitulo.

PAINEL DE CONTROLO (CONTROL PANEL)

O local onde estdo todas as opg¢oes de configuracdo do sistema operativo, é o Painel de Controlo
(Control Panel), presente no Windows desde as suas primeiras versoes:

¢ Iniciar » Painel de Controlo (Start » Control Panel) (Figura 42)
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FIGURA 42 - PAINEL DE CONTROLO

No Windows XP pode-se clicar em "Switch to Classic View" para obter uma visualiza¢io idéntica a
uma pasta normal, e mais parecida com as versdes antigas. Das diferentes tarefas de configuracdo
as que nos interessam sao as de customizagao:

e Aspecto (Appearance and Themes) - permite mudar o aspecto do windows
e Contas de Utilizador (User Accounts) - contas de utilizador

Os restantes tarefas de configuracdo, na sua maior parte podem ser consultadas, mas apenas
alteradas pelo administrador.

Comecemos pelo Aspecto (Figura 43):
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FIGURA 43 - ASPECTO (APPEARANCE AND THEMES)

No Windows XP pode-se optar por clicar numa tarefa (estao listadas as mais comuns) ou abrir uma
dialog de configuracdo, a partir de cada um dos trés icones em baixo, que é o que iremos fazer dado
que é mais completo. No Windows 7 estdo desde logo listadas as sub-tarefas de cada conjunto de
opcdes. Todas estas alternativas de seleccdo pode dar a falsa sensagdo que ha muitas configuracoes
a fazer, mas as alternativas estdo disponiveis apenas para facilitar a navegacdo até a dialog de
configuracdo pretendida.

VISUALIZACAO (DISPLAY)

As opgdes disponiveis de visualizagio no Windows XP e Windows 7 sdo idénticas, no entanto
apresentam formas de configuragdo distintas, pelo que vamos primeiramente apresentar as dialogs
do Windows XP.
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FIGURA 44 - DIALOG DE PROPRIEDADES DE VISUALIZACAO (DISPLAY) NO WINDOWS XP

Esta dialog tem 5 pastas (Figura 44). A primeira permite trocar o tema do Windows. Significa que a
aparéncia de todas as aplicagoes, incluindo o rato, pode ser mudado, parecendo que estamos com
outro sistema operativo, mas na verdade apenas se muda o aspecto do Windows. Pode-se inclusive
obter mais temas se se estiver ligado a internet.

Na segunda pasta podemos escolher a imagem de fundo do ambiente de trabalho.

Na terceira pasta pode-se escolher qual é a protec¢io de ecra (screen saver). Quando o computador
fica inactivo durante muito tempo, a aplicacdo proteccio de ecra (screen saver) é activada de forma
a protejer o ecrd, que de outra forma poderia ficar danificado por manter sempre a mesma imagem
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fixa. Nesta pasta pode-se controlar o tempo de inactividade necessario para activar a protec¢ao de
ecra (screen saver).

Na quarta pasta pode-se mudar a aparéncia em termos de cores das janelas, bem como o tamanho
da fonte do sistema. Pode-se ainda com o botdo "Effect" controlar mais aspectos do funcionamento
do Windows. O botdo "Advanced" permite ter um controlo fino sobre as cores e aspecto de cada
componente.

Na quinta pasta pode-se controlar a resolucdo do ecrd, ndo s6 o numero de pixels, como a
quantidade de cores em cada pixel. Se o computador tiver dois monitores pode-se extender um dos
monitores para o outro, aumentando assim a area de trabalho. O botdo "Advanced" permite alterar
mais opgdes mas que devem ser feitas por um administrador.

Experimente personalizar um pouco a sua conta, por exemplo, se utilizar um monitor com
resolucdo muito elevada, podera ter interesse em aumentar o tamanho de letra do Windows.

Passamos agora as dialogs de configuracao no Windows 7:
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FIGURA 45 - OPCOES DE VISUALIZAGCAO (DISPLAY) NO WINDOWS 7

A vista tem na zona lateral esquerda a lista das diferentes janelas de visualizacdo, as quais as mais
importantes estdo na Figura 45. A primeira janela permite alterar os itens, ideal no caso de se
utilizar resolucdes no ecrd muito elevadas. A segunda janela permite alterar a resolucdo do ecra,
bem como gerir os diferentes monitores no caso de haver mais que um, tal como no Windows XP a
quinta pasta da dialog visualizacdo (display). A terceira janela permite alterar o estilo das janelas e
cores, existindo também um botdo “Avancadas” para ter controle mais detalhado. A quarta janela
permite definir a proteccdo de ecra (screen saver), tal como no Windows XP a terceira pasta da
dialog visualizacao (display).

MENU INICIAR E BARRA DE TAREFAS (TASKBAR AND START MENU)

Vamos agora passar para as propriedades do menu Iniciar e barra de tarefas (taskbar and start
menu). A dialog no Windows XP tem duas pastas, conforme se apresenta na Figura 46.
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FIGURA 46 - DIALOG DE PROPRIEDADES DO MENU INICIAR E BARRA DE TAREFAS NO WINDOWS XP

Na pasta da barra de tarefas (taskbar) podem-se tomar diversas op¢des sobre o espaco que a barra
ocupa. Pode experimentar alterar a barra de tarefas de forma a obter o melhor funcionamento para
si, muito embora as configuracdes de omissdo sejam Uteis para a maior parte das pessoas.

Na pasta do menu iniciar pode-se alterar a configuragdo do menu iniciar, ou entdo mudar para o
formato classico do Windows. No botdo de customizacdo pode-se tomar diversas op¢des nao sé no
tamanho dos icones, como no numero de aplicacdes mais utilizadas, entre outras opcgdes.
Novamente as configuracdes de omissao possivelmente serdo as mais dteis para a maior parte das
pessoas, mas quem esteja habituado a versdes do windows antigas, pode preferir o formato classico
do menu iniciar.

Vamos agora ver (Figura 47) as dialogs de configuracdo das propriedades do menu Iniciar e barra
de tarefas (taskbar and start menu) no Windows 7.
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FIGURA 47 - DIALOG DE PROPRIEDADES DO MENU INICIAR E BARRA DE TAREFAS NO WINDOWS 7

No Windows 7, a pasta de configuracdo da barra de tarefas tem opg¢des idénticas ao Windows XP. A
pasta de configuracdo do menu Iniciar fornece também acesso a uma dialog com configuracdo mais
personalizada, mas destaca duas opg¢bes importantes de privacidade: lista das aplicacoes
recentemente abertas; lista dos documentos recentemente abertos. Estas opcdes vém seleccionadas
por omissdo, dado que aumenta certamente a produtividade, mas o utilizador podera ponderar a
sua utilizagdo dado que assim tanto as suas ultimas aplicagdes como os seus ultimos documentos
editados podem inadvertidamente serem mostrados a terceiros.
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OPCOES DE PASTAS (FOLDER OPTIONS)

Vamos passar agora as opg¢des das pastas (folder options).
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FIGURA 48 - DIALOG DE PROPRIEDADES DAS PASTAS

Esta dialog (Figura 48) permite efectuar configuragdes de apresentagio aplicavel a todas as pastas.
Pode-se alterar o aspecto das pastas para um formato classico do Windows, e também colocar o
explorador do windows para abrir os ficheiros com um s6 clique, e ndo duplo clique. Se nio estiver
a efectuar muitas manipulacdes de ficheiros e pastas, o modo de abrir os ficheiros com um s6 clique
podera ser mais eficiente.

As restantes pastas da dialog sdo mais técnicas, destinadas a administradores do sistema.

CONTAS DE UTILIZADOR (USER ACCOUNTS)

Na configuragdo das contas de utilizador (Figura 49), pode-se alterar a imagem de login e colocar
uma password. E conveniente colocar uma password, caso contrario qualquer pessoa que tenha
acesso ao computador pode entrar na sua area.
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FIGURA 49 - DIALOG DE CONFIGURAGCAO DE CONTA DE UTILIZADOR

Na imagem ndo existe op¢do para criar / alterar uma password porque a conta é de convidado. A
conta de convidado pode estar ligada ou desligada num computador, e permite a uma pessoa que
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nao seja utilizador habitual do computador utiliza-lo, sem que assim sejam expostos os documentos
dos utilizadores habituais.

GESTOR DE TAREFAS (TASK MANAGER)

Antes de terminar este capitulo, é conveniente apresentar o Gestor de Tarefas (Task Manager),
aplicacdo responsavel por gerir a execucdo de todas as aplicagdes. E chamada através da sequéncia
de teclas Ctrl+Alt+Delete premidas em simultaneo.
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FIGURA 50 - GESTOR DE TAREFAS (TASK MANAGER)

O gestor de tarefas (task manager) tem varias pastas mas as duas mais relevantes para um
utilizador que ndo seja administrador é a pasta Aplicacbes (Applications) e a pasta Desempenho
(Performance), que se apresentam na Figura 50.

A pasta Aplicagdes (Applications) contém a lista de aplica¢des abertas, sendo mostrado o estado de
cada aplicacdo. No caso de uma aplicacao ficar pendurada a informagao na coluna Estado (Status) é
alterada. O utilizador tem hipétese de mandar fechar abruptamente a aplicagdo (Terminar Tarefa
ou End Task), embora apenas o deva fazer em ultimo caso, dado que desta forma ira perder as
alteracdes que fez desde a ultima vez que gravou o documento.

A pasta Desempenho (Performance) mostra a carga do CPU no grafico superior, de forma a permitir
monitorizar a carga no caso do computador comegar a ficar lento. Se estiverem muitos processos
em simultaneo, é natural que o computador fique lento. Pode-se também ver nos graficos da
segunda linha a utilizacdo de memoria. Se houver pouca memoria o sistema operativo fica mais
lento, dado que tem que utilizar memoria secundaria.
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